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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 

 

 
EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the European 
Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
use of any information contained in this document complies with all relevant export control regulations. ECN N /A. 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 7.1.0 
(part numbers (PNRs) software license: 608-001-000-001/Codes 
and software: 609-010-000-001 on physical media (USB device (flash drive/key))). 

This document contains information about changes to the software since the previously released version 
(VibroSight 6.1.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-225A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-231A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-211A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 7.0.0 (document reference 660-010-013-233A) 

• VibroSight 6.1.0 (document reference 660-010-013-232A) 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 
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• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 
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• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, the RLC16Mk2 relay module and the 
CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 

 

 

  



 

RELEASE NOTES 
VibroSight® 7.1.0 
8 / 72 

Document reference VIBROSIGHT-RN/E (660-010-013-234A) 
Version 34 – 08.08.2022 

 

TABLE OF CONTENTS 
 

1 Licensing ........................................................................................................................................ 11 
2 Features ......................................................................................................................................... 11 

General .............................................................................................................................................. 11 
2.1 VM600Mk2 MPC4Mk2 support for hydro air-gap monitoring and analysis ............................ 11 
2.2 VM600Mk2 MPC4Mk2 support for shaft absolute vibration processing ................................. 12 
2.3 VM600Mk2 MPC4Mk2 support for custom processing .......................................................... 14 
2.4 VM600Mk2 systems, VibroSight Capture and VSHDA data source import ......................... 16 
2.5 VM600Mk2 systems, VibroSight Capture and OPC and OPC UA clients ........................... 18 
2.6 VM600Mk2 MPC4Mk2 fault relay configuration ..................................................................... 20 
2.7 VM600Mk2 MPC4Mk2 user-configurable relay configuration ................................................ 20 
2.8 VM600Mk2 MPC4Mk2 sensor power supply defaults ............................................................ 21 
2.9 Sensor catalog changes .................................................................................................... 21 
2.10 Sensor configuration improvements .................................................................................. 22 
2.11 VibroSight Protect configuration export ............................................................................. 22 
2.12 VibroSight System Manager and VibroSmart PTP time synchronisation .......................... 23 
2.13 VibroSight Capture and MPC4Mk2 modules ....................................................................... 23 
2.14 VibroSight Vision and Trend plots against speed and against time .................................. 24 
2.15 Machinery view changes ................................................................................................... 25 

VM600Mk2 modules ............................................................................................................................ 26 
2.16 MPC4Mk2 + IOC4Mk2 module ............................................................................................... 26 
2.17 CPUMMk2 + IOCNMk2 module.............................................................................................. 28 

VM600 modules ................................................................................................................................. 29 
2.18 CPUR2 + IOCR2 module ................................................................................................... 29 

VibroSmart modules .......................................................................................................................... 29 
2.19 VSN010 module ................................................................................................................. 29 
2.20 VSV301 + VSB300 module ................................................................................................ 30 
2.21 VSI010 + VSB010 module ................................................................................................. 30 

3 Solved problems and bug fixes ...................................................................................................... 32 
3.1 General improvements and bug fixes ................................................................................ 32 
3.2 Incorrect Raw bus line used to drive a RLC16Mk2 relay ..................................................... 32 
3.3 Incorrect tacho could be selected as a speed reference ................................................... 32 
3.4 Inconsistent treatment of VibroSight Protect and VibroSight Capture configurations 

after updates ...................................................................................................................... 32 
3.5 VibroSight System Manager .............................................................................................. 32 
3.6 Math processing block missing configuration elements .................................................... 33 
3.7 Differential shaft expansion consistency check error ........................................................ 33 
3.8 Inconsistent treatment of the Hardware and Machinery views in VibroSight Vision and 

VibroSight Mimic ................................................................................................................ 33 
3.9 Shaft axial position measurements with auxiliary channels............................................... 33 



 

Document reference VIBROSIGHT-RN/E (660-010-013-234A) 
Version 34 – 08.08.2022 

RELEASE NOTES 
VibroSight® 7.1.0 

9 / 72 
 

4 Known issues ................................................................................................................................. 34 
4.1 Security risks ...................................................................................................................... 34 
4.2 Display of timestamps in VibroSight Vision ....................................................................... 34 
4.3 VibroSight Server and Host Service restart required after changes to network adapter ... 34 
4.4 Length limitation of VibroSight Server instance names ..................................................... 34 
4.5 Display of timestamps in VibroSight clients other than VibroSight Vision ......................... 35 
4.6 Display of devices in VibroSight System Manager ............................................................ 35 
4.7 VibroSight Mimic backwards compatibility ......................................................................... 36 
4.8 VibroSight OPC Clients not recovering .............................................................................. 36 
4.9 Duplicate events ................................................................................................................ 37 
4.10 VibroSight Server status indicators .................................................................................... 37 
4.11 XMx16 card pre-logging ..................................................................................................... 37 
4.12 Problems creating new VibroSight OPC Classic Servers .................................................. 37 
4.13 Potential TCP port 50000 conflict ...................................................................................... 39 
4.14 Problems using shared network drives/locations for VibroSight data management ......... 39 
4.15 Problems installing VibroSight 3.7.x on computers without internet access ..................... 40 

5 Compatibility .................................................................................................................................. 41 
5.1 VibroSight software ............................................................................................................ 41 

5.1.1 Microsoft Windows operating systems .................................................................. 42 
5.1.2 Microsoft .NET Framework .................................................................................... 42 
5.1.3 Microsoft Visual C++ Redistributable Package...................................................... 43 
5.1.4 OPC Core Components Redistributable ................................................................ 43 
5.1.5 OPC UA Local Discovery Server ........................................................................... 43 
5.1.6 Sybase SQL Anywhere 11 software ...................................................................... 44 
5.1.7 Dell Backup and Recovery software ...................................................................... 44 
5.1.8 MatrikonOPC software ........................................................................................... 45 

5.2 VM600Mk2/VM600 modules/cards ...................................................................................... 46 
5.2.1 Module/card firmware ............................................................................................ 46 

5.3 VibroSmart devices ............................................................................................................ 47 
5.3.1 Module firmware .................................................................................................... 47 

6 Upgrade procedure ........................................................................................................................ 48 
6.1 VibroSight software user settings ...................................................................................... 48 
6.2 Updating VibroSight-compatible hardware ........................................................................ 49 

6.2.1 VM600Mk2/VM600 module/card firmware ............................................................... 49 
6.2.2 VibroSmart device firmware ................................................................................... 59 
6.2.3 Updating the firmware using VibroSight System Manager .................................... 66 

6.3 Final checks ....................................................................................................................... 68 
  



 

RELEASE NOTES 
VibroSight® 7.1.0 
10 / 72 

Document reference VIBROSIGHT-RN/E (660-010-013-234A) 
Version 34 – 08.08.2022 

 

7 Customer support .......................................................................................................................... 69 
7.1 Contacting us ..................................................................................................................... 69 
7.2 Technical support ............................................................................................................... 69 
7.3 Sales and repairs support .................................................................................................. 69 

Appendix ............................................................................................................................................ 70 
VibroSight software and Windows® operating system compatibility .......................................... 71 
VibroSight software and Windows® Server operating system compatibility .............................. 71 
VibroSight software and Microsoft® .NET Framework requirements ......................................... 72 

  



 

Document reference VIBROSIGHT-RN/E (660-010-013-234A) 
Version 34 – 08.08.2022 

RELEASE NOTES 
VibroSight® 7.1.0 

11 / 72 
 

1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.1.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 7.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 7 Customer support. 

 

2 Features 

General 

2.1 VM600Mk2 MPC4Mk2 support for hydro air-gap monitoring and analysis 

VibroSight 7.1.0 adds support for hydro air-gap monitoring and analysis using data from 
VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules – equivalent to the existing 
support for this hydro application processing using data from VM600Mk2/VM600 XMV16 modules and/or 
VibroSmart VSV30x modules. 

NOTE: The VibroSight “Hydro air-gap monitoring” package allows the air gap between 
rotor and stator, and the rotor and stator shapes (geometrical data) to be monitored 
for hydroelectric generators. It also allows the magnetic flux (magnetic flux density, 
also known as magnetic field strength) of the air gap to be monitored. 

The VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring 
modules now supports hydro air-gap monitoring and analysis only. Additional 
support for magnetic-flux monitoring and analysis will be added in a future release. 

 

It is important to note that the base/standard edition of the VibroSight software (that is, VibroSight Classic) includes 
the Hydro air-gap monitoring package in addition to providing full support for vibration analysis, including a 
complete catalogue of plots and the functionality required for the display and analysis of absolute vibration, relative 
vibration, position, displacement, eccentricity expansion and so on. 

 

More specifically, VibroSight Protect now allows VM600Mk2 MPC4Mk2 dynamic channels (CH1-CH4) to be 
configured for use with air-gap sensors and air-gap processing functions. 

When configuring a dynamic channel for use with air-gap sensors, such as LS12x and ILS73x air-gap 
measurement systems, select Processing type: Single, Sensor family: Airgap sensors, then Air gap. 
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Then, when prompted to configure the sensor / measurement chain (Configuration of a channel), from the Library, 
select a LS12x sensor and ILS73x signal conditioner from the list in order to use a sensor / measurement chain 
with default values. Alternatively, under the Library list, use the Add control to add a new sensor chain (vibro-meter 
or generic) to the list, or use the Duplicate and/or Edit controls to modify an existing sensor / measurement chain, 
as required. 

(VibroSight Protect configures MPC4Mk2 module air-gap sensor / measurement chains to use AC + DC signal 
coupling with the analogue high-pass filter disabled.) 

 

NOTE: A LS12x and ILS73x air-gap measurement system provides three output signals: 
POLE PROFILE, ROTOR PROFILE and MIN GAP. 

It is important to note that the POLE PROFILE output signal must be used as the 
input to a VM600Mk2 MPC4Mk2 + IOC4Mk2 module for applications that require both 
machinery protection and condition monitoring functionality. 

For reference, first-generation VM600 (VM600Mk1) MPC4 + IOC4T cards supported 
the MIN GAP output signal only and provided machinery protection only. 
That is, the POLE PROFILE (effectively, a “raw” signal) is required for condition 
monitoring, while the MIN GAP is suitable for machinery protection only. 

 

 

2.2 VM600Mk2 MPC4Mk2 support for shaft absolute vibration processing 

VibroSight 7.1.0 adds improved support for shaft absolute vibration (SAV) processing and measurements, more 
specifically X-Y bearing absolute vibration, using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic channels. 

NOTE: VibroSight / VM600Mk2 MPC4Mk2 “X-Y bearing absolute vibration” processing and 
“X-Y shaft relative vibration” processing are similar types of dual-channel 
processing that provide similar outputs: 

• X-Y bearing absolute vibration processing requires two velocity sensor based 
sensors / measurement chains and provides a Vmax vibration 
measurement output (in terms of velocity, such as mm/s). 

• X-Y shaft relative vibration processing requires two proximity sensor based 
sensors / measurement chains and provides a Smax vibration 
measurement output (in terms of displacement, such as µm). 

 

More specifically, VibroSight Protect now allows VM600Mk2 MPC4Mk2 dynamic channels to be configured for dual-
channel X-Y bearing absolute vibration processing functions using velocity sensors (moving-coil or piezoelectric) 
on CH1-CH2 and/or CH3-CH4. 

When configuring the dynamic channels for use with velocity sensors (moving-coil or piezoelectric), select 
Processing type: Dual, Sensor family: Velocity sensors or velocimeters, then X-Y bearing absolute vibration. 
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Then, when prompted to configure the sensors / measurement chains (Configuration of a channel), use the Add 
control to select the velocity sensors or velocimeters from the Library in order to use a sensor / measurement chain 
with default values. Alternatively, under the Library list, use the Add control to add a new sensor chain (vibro-meter 
or generic) to the list, or use the Duplicate and/or Edit controls to modify an existing sensor / measurement chain 
as required. 

 

In VibroSight Protect, when configuring X-Y bearing absolute vibration for machinery protection, it is important to 
note that: 

• The X-Y velocity sensors must have mounting orientations (radial positions) that are at least 30° apart. 
VibroSight Protect will use a default value of 90°. 

• Both X-Y velocity sensors must have the same filter settings (Frequency Span and Filter type). 

• The default calculation method for Vmax uses the real maximum displacement value directly from the orbit, that 
is, the largest radius from the unfiltered orbit. This is a peak measurement. 
Alternatively, Vmax can be calculated using an X-Y max discriminator that uses the maximum value of the 
peak-to-peak displacement values measured in two orthogonal directions of the unfiltered orbit. This is a 
peak-peak measurement. 

 

In VibroSight Capture, when configuring X-Y bearing absolute vibration for condition monitoring on the Configure 
tab/page, it is important to note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 

• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

• For X-Y bearing absolute vibration for condition monitoring, Orbits (OVR orbit, 1X orbit, 2X orbit) and a 
Full spectrum with default measurements (1X, 2X, 3X, Not 1X) are configured by default. 

NOTE: For the orbits, in addition to the unfiltered overall orbit (OVR orbit), a maximum of 
6 filtered orbits are permitted (1n orbit). 

For the Full spectrum, the window type is Hanning and the spectrum resolution is 
1600 lines (both fixed), while averaging is configurable. In addition, a maximum of 
6 highly-configurable frequency domain extractions/measurements are permitted. 
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In general, on the Processing tab, under Condition monitoring, the default setttings can be changed as required. 
On the Alarms tab, under Condition monitoring, alarms can also be added as required. 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 

 
 

2.3 VM600Mk2 MPC4Mk2 support for custom processing 

VibroSight 7.1.0 adds support for custom processing and measurements, more specifically, Custom dynamic 
and/or Custom quasi-static using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s dynamic channels, and 
Custom quasi-static processing using the VM600Mk2 MPC4Mk2 + IOC4Mk2 module’s auxiliary channels 

NOTE: VibroSight / VM600Mk2 MPC4Mk2 Custom dynamic processing and 
Custom quasi-static processing functions can be used by sensors / measurement 
chains created in the Other sensors category/section of the sensor catalogue. 
See also 2.9 Sensor catalog changes. 

 
More specifically, VibroSight Protect now allows VM600Mk2 MPC4Mk2 dynamic channels to be configured for 
Custom dynamic processing and/or Custom quasi-static processing functions using custom/other sensors on 
CH1-CH4. It also allows VM600Mk2 MPC4Mk2 auxiliary channels to be configured for Custom quasi-static processing 
functions using custom/other sensors on AX1-AX2. 

 
When configuring dynamic or auxiliary channels for use with custom/other sensors, select Processing type: Single, 
Sensor family: Other sensors, then Custom dynamic or Custom quasi-static, as appropriate. 

Then, when prompted to configure the sensor / measurement chain (Configuration of a channel), from the Library, 
select the sensor / measurement chain from the list in order to use a previously created custom/other sensor with 
default values. Alternatively, under the Library list, use the Add control to add a new generic sensor chain to the 
list, or use the Duplicate and/or Edit controls to modify an existing sensor / measurement chain as required. 

 
In VibroSight Protect, when configuring Custom dynamic processing for machinery protection, it is important to note 
that: 

• A dynamic (AC) type custom/other sensor is required. 

• A dynamic (CH1-CH4) or auxiliary (AX1-AX2) channel can be used. 

• Fixed frequency or Order tracking data acquisition can be selected, and most parameters (Frequency span, 
Window type, etc.) can be freely configured. 

• A single “overall” measurement is available by default. Additional frequency domain and/or time domain 
measurements and alarms can be added. 
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In VibroSight Protect, when configuring Custom quasi-static processing for machinery protection, it is important to 
note that: 

• A quasi-static (DC) type custom/other sensor is required. 

• An auxiliary (AX1-AX2) channel can be used. 

• Only a single quasi-static “overall” measurement (and alarm) is available. 

 

In VibroSight Capture, when configuring Custom dynamic processing for condition monitoring, it is important to 
note that: 

• For the component/processing selected in the Machinery image (top), the name and type of measurement is 
displayed (bottom, left), while more detailed information for the associated processing and measurements is 
displayed (bottom, centre) across three tabs: General, Processing and Alarms. 

• The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the 
VibroSight Protect configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

• For Custom dynamic processing for condition monitoring, no waveform or spectrum measurements are 
configured by default. 

 

In general, on the Processing tab, under Condition monitoring, the default setttings can be changed as required. 
On the Alarms tab, under Condition monitoring, alarms can also be added as required. 
 

NOTE: It is important to note that in VibroSight Capture, any machinery protection system 
(MPS) information is displayed for information only and cannot be edited. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 
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2.4 VM600Mk2 systems, VibroSight Capture and VSHDA data source import 

For Vibrosight VM600Mk2 systems, VibroSight Capture is used to configure the system interfaces associated with a 
VibroSight database/system, such as: 

• A VibroSight Protect configuration – used as the basis for a VibroSight Capture configuration. 

NOTE: It is important to note that when using VibroSight Capture to configure a VM600Mk2 
system for condition monitoring, the condition monitoring (CMS) configuration 
builds on the existing machinery protection (MPS) configuration, as defined using 
VibroSight Protect. 

 

And now … 

• VSHDA data source (VibroSight historical data archive (*.vshda) files) – used for external data file import 
(database mirroring). 

NOTE: Remote VibroSight database (*.vshda) files can be imported into a local VibroSight 
Server (*.vshdf) in order to create a replica/mirror of the remote VibroSight system 
to support applications such as central diagnostics centres, with file generation, 
importation and synchronisation all performed automatically in quasi real-time. 
While primarily intended for remote monitoring and diagnostics applications 
working with monitoring systems installed in cyber-secure environments (behind a 
‘data diode’ or firewall), this feature is also useful for remote sites that have 
unreliable network connections. 

 

In VibroSight Capture, to use a VSHDA data source to import data into a VibroSight database/system: 

 

• Use the Systems tab/page to add the VSHDA data source interface. 

In the main window (centre), click on the “+” (add a system) box to display the new system window, then select 
a VSHDA data source to add the interface device, as required. 
The VSHDA data source icon is added to the Systems tab/page. 

 

• On the Systems tab/page, configure the VSHDA data source interface. 

In the main window (centre), click on the VSHDA data source icon to select it. 
The VSHDA data source parameters are displayed in the main window (centre) and can be edited as required. 

Note: At any time, clicking on Return to systems (main window, centre, top right) will return to the main (home) 
view of the Systems tab/page. 

Configuring a VSHDA data source requires that the following parameters are configured: 

• Enabled, Name, Description, Input directory, Remove VSHDA files after processing, 
Remove invalid VSHDA files. 
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Where: 

Enabled: An external VSHDA data source is Enabled by default but can be Disabled, as required. 
Name: Use the default name for the external VSHDA data source or change it, as required. 
Description: Optional text to help describe the configuration/application. 
Input directory: The location of the folder containing the VibroSight historical data archive (*.vshda) files from a 
remote site, that is, the external VSHDA data files. 
NOTE: This can be a folder on the computer running the central VibroSight Server or a network 
directory/folder. 
Remove VSHDA files after processing: When this check box is selected, the central VibroSight Server will 
automatically delete a VibroSight historical data archive (*.vshda) file from the input folder after it has finished 
with it. 
NOTE: It can be useful to see the VibroSight historical data archive (*.vshda) files in the input folder when 
initially configuring and working with a central VibroSight Server. But once the system is working as expected, it 
is recommended to select this check box to automatically delete them in order to reduce storage requirements 
(avoiding potential issues such as a disk-full situation). 

Remove invalid VSHDA files: When this check box is selected, the central VibroSight Server will automatically 
delete from the input folder any VibroSight historical data archive (*.vshda) files that do not match the remote 
VibroSight Server’s unique ‘configuration identifier (GUID)’ or any data archive files that are corrupted. 
NOTE: A central VibroSight Server automatically extracts and uses the remote VibroSight Server’s 
‘configuration identifier (GUID)’ from the first VibroSight historical data archive (*.vshda) file copied to its Input 
directory folder. 

 

Using a VSHDA data source to import data into a central VibroSight database/system requires that the remote 
VibroSight Server is configured to generate VibroSight historical data archive (*.vshda) files at a data rate that is 
suitable for the application. The data update rate required for the remote monitoring and diagnostics of live data is 
usually of the order of minutes. 

A third-party tool is then used to copy the VibroSight historical data archive (*.vshda) files from a remote site 
(higher-security level) – via a secure data diode – to a central diagnostics centre (lower-security level). 

NOTE: Since data diodes are unidirectional, it is not possible to use them to gain access to 
and interfere in the operation of the machinery being monitored. 

 

In the diagnostics centre, a central VibroSight Server acts as replica/mirror data repository for the remote site. 
That is, the central VibroSight Server automatically accesses and collates the data from the VibroSight historical 
data archive (*.vshda) files copied from a remote site. In this way, a local data repository (VibroSight historical data 
folder (*.vshdf) file) is created that is suitable for remote monitoring and diagnostics. 

 

When working with VSHDA data source configurations, the Consistency checks window (bottom) can be used to 
run and/or display consistency check information so that any problems in the VM600Mk2 system configuration can 
be corrected. 

Also, the VibroSight Capture configuration is saved and activated in the usual way, that is, using the 
File > Save as server and/or the File > Apply changes to active configuration menu commands, as appropriate. 
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Finally, once the VibroSight Server is up and running, the Server feature required by the VSHDA data source 
(VSHDA import) must be enabled via the server’s user interface, as appropriate. 

 

 

2.5 VM600Mk2 systems, VibroSight Capture and OPC and OPC UA clients 

For Vibrosight VM600Mk2 systems, VibroSight Capture is used to configure the system interfaces associated with a 
VibroSight database/system, such as: 

• A VibroSight Protect configuration – used as the basis for a VibroSight Capture configuration. 

NOTE: It is important to note that when using VibroSight Capture to configure a VM600Mk2 
system for condition monitoring, the condition monitoring (CMS) configuration 
builds on the existing machinery protection (MPS) configuration, as defined using 
VibroSight Protect. 

 

And now … 

• OPC devices and OPC UA devices – used for the import of external data via OPC into a VibroSight database, 
for example, from third-party systems such as a DCS or PLC. 

In VibroSight Capture, to use an OPC device or OPC UA device to import data into a VibroSight database/system: 

 

• Use the Systems tab/page to add the OPC or OPC UA interface, depending on the application. 

In the main window (centre), click on the “+” (add a system) box to display the new system window, then select 
an OPC device or an OPC UA device to add the interface, as required. 
The OPC device or OPC UA device icon is added to the Systems tab/page. 

 

• On the Systems tab/page, configure the OPC and/or OPC UA device interface. 

In the main window (centre), click on the OPC device or OPC UA device icon to select it. 
The OPC device or OPC UA device parameters are displayed in the main window (centre) and can be edited 
as required. 

Note: At any time, clicking on Return to systems (main window, centre, top right) will return to the main (home) 
view of the Systems tab/page. 

For example, configuring an OPC device requires that the following parameters are configured: 

• Enabled, Name, Description, Host name or address, Authentication settings (with Test), OPC server name 
(with browse), Authentication settings (with Test). 

For example, configuring an OPC UA device requires that the following parameters are configured: 

• Enabled, Name, Description, OPC UA server URL (with Browse), Security policy, Message security mode, 
Authentication settings. 
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• On the Systems tab/page, configure the OPC and/or OPC UA device tag groups. 

In the main window (centre), click on the OPC device or OPC UA device icon to select it. 
The OPC device or OPC UA device parameters are displayed in the main window (centre). 
In the Tag groups window (left), click on the “+ Tag group n” box to add a tag group to the device. 
The tag group is displayed in the main window (centre) and can be edited as required. 

Note: At any time, clicking on Return to systems (main window, centre, top right) will return to the main (home) 
view of the Systems tab/page. Similarly, the System window (right) can be used to switch between the system 
level and the device (interface) level. 

For example, configuring an OPC device tag group requires that the following parameters are configured, 
under the General tab: 

• Enabled, Name, Description, Update rate, Read mode. 

For example, configuring an OPC UA device tag group requires that the following parameters are configured, 
under the General tab: 

• Name, Enabled, Name, Description, Publishing interval. 

 

 

• On the Systems tab/page, configure the individual OPC and/or OPC UA device tags for a tag group. 

In the main window (centre), click on the OPC device or OPC UA device icon to select it. 
The OPC device or OPC UA device parameters are displayed in the main window (centre). 
In the Tag groups window (left), click on a “Tag group n” box to select it. 
The tag group is displayed in the main window (centre). 
In the main window (centre), click on the Tags tab to select it. 
The Tags tab can be used to add and edit individual device tags as required. 

On the Tags tab, the Add control (bottom left) is used to add a new tag to a tag group. 
When a tag is added/selected (left), the main window (right) displays the information for the tag, which can be 
configured/edited as required by the application. 
Alternatively, the Import from CSV and/or Export to CSV controls can be used to import multiple tags from a 
comma-separated values (CSV) file, generated using software such as Excel®). 

Note: At any time, clicking on Return to systems (main window, centre, top right) will return to the main (home) 
view of the Systems tab/page. Similarly, the System window (right) can be used to switch between the system 
level and the device (interface) level. 

 

When working with OPC device and/or OPC UA device configurations, the Consistency checks window (bottom) 
can be used to run and/or display consistency check information so that any problems in the VM600Mk2 system 
configuration can be corrected. 

Also, the VibroSight Capture configuration is saved and activated in the usual way, that is, using the 
File > Save as server and/or the File > Apply changes to active configuration menu commands, as appropriate. 

Finally, once the VibroSight Server is up and running, the Device driver required by the OPC device (OPC) and/or 
OPC UA device (OPC UA) must be enabled via the server’s user interface, as appropriate. 
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2.6 VM600Mk2 MPC4Mk2 fault relay configuration 

VibroSight 7.1.0 now allows the common circuit-fault relay (FAULT) of a VM600Mk2 MPC4Mk2 + IOC4Mk2 module to 
be driven by different inputs, depending on the requirements of an application. 

NOTE: Located on the IOC4Mk2 module, there is one common circuit-fault relay (FAULT) 
available for use by an application. This relay is automatically driven by the 
MPC4Mk2 module in order to indicate the status of the module/system, notably any 
problems detected by the MPC4Mk2 module’s internal diagnostics (that is, built-in 
self-test (BIST)). 

 

Basically, the input to the FAULT relay can now be configured to be driven by either: 

• A failure in the MPC4 card or the VM600 power supply, or 

• A failure in the MPC4 card or the sensor chains or the VM600 power supply. 

(Previously, the input to the FAULT relay was always driven by “A failure in the MPC4 card or the VM600 power 
supply”, that is, it was not configurable.) 

The new option to drive the FAULT relay by “A failure in the MPC4 card or the sensor chains or the VM600 power 
supply” is similar to the existing option but also takes into the account the sensor / measurement chain OK checks 
on the MPC4Mk2 module itself. 

 

 

2.7 VM600Mk2 MPC4Mk2 user-configurable relay configuration 

VibroSight 7.1.0 now allows the user-configurable relays (RL1 to RL4) of a VM600Mk2 MPC4Mk2 + IOC4Mk2 module 
to be driven by different inputs, depending on the requirements of an application. 

NOTE: Located on the IOC4Mk2 module, there are four user-configurable relays (RL1 to 
RL4) available for use. This relays are free to be configured by the user, depending 
on the requirements of an application. 

 

Basically, the input to a user-configurable relay can now be configured to be driven as follows: 

• Via a logical function configured on the module. 

• Via an individual status information bit related to the status of measurement channels or the module itself. 

(Previously, the input to a user-configurable relay always had to be driven by a logical function.) 

The new option to drive a user-configurable relay via individual status information bit means that it is now possible 
to drive a user-configurable relay without using a “dummy” logical function. 

 

Note: Data validity flags have also been removed from the list of options (status information bits) that can be used 
as inputs to logical functions, as it is not recommended to drive relays with such information. 
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2.8 VM600Mk2 MPC4Mk2 sensor power supply defaults 

VibroSight 7.1.0 now configures the sensor power supply for a VM600Mk2 MPC4Mk2 measurement channel with a 
default value (Disabled, +24 VDC, −24 VDC or 6 mA) based on the sensor / measurement chain configured for the 
channel. 

More specifically: 

• For a vibro-meter sensor / measurement chain, the sensor power supply will use a default value that 
corresponds to the sensor / measurement chain. 
For example, for a measurement chain using an IPC70x signal conditioner, Sensor power supply: 24 [V], 
while for a measurement chain using an IQS900 signal conditioner, Sensor power supply: −24 [V], 
while for a measurement chain using an CE6xx, Sensor power supply: 6 [mA]. 

• For a generic (non-vibro-meter) sensor / measurement chain, the sensor power supply will be disabled by 
default. That is, Sensor power supply: Disabled. 

 

 

2.9 Sensor catalog changes 

The sensor catalogue used by VibroSight Protect for the configuration of sensor / measurement chains has been 
expanded to include even more vibro-meter sensor / measurement chains, including the latest versions of the 
recently introduced CE6xx and PV6xx general-purpose vibration sensors: 

• CE630 and CE687 piezoelectric accelerometers. 

• PV660 and PV685 piezoelectric velocity sensors. 

 

Also in the sensor catalogue, in order to support machinery monitoring applications such as valve monitoring, two 
new physical quantities have been added: 

• Stiffness with default units of kN/m. 
Configurable units: N/m, kN/m, MN/m or lb/in. 

• Surface with default units of mm2. 
Configurable units: m2, km2, cm2, mm2, in2. 

 

Finally, in the sensor catalogue, a new category/section for Other sensors has been added in order to allow users 
to more easily create and manage non-standard (generic) sensors / measurement chains. 

Sensors / measurement chains created in the Other sensors category/section of the sensor catalogue can be used 
by the new custom processing functions/types (Custom dynamic and/or Custom quasi-static).  

When creating a custom/other sensor in the Other sensors category/section of the sensor catalogue, any physical 
quantity available in the catalogue (from Acceleration to Weight ratio) can be used to help determine the sensor’s 
sensitivity, while configuring the sensitivity in voltage or current units determines whether the sensor is voltage or 
current output. The sensor’s range and offset can also be configured. Finally, the Sensor output type 
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(Dynamic (AC) or Quasi-static (DC)) must be selected in order to determine whether the sensor is suitable for use 
with the dynamic and/or auxiliary channels of a monitoring module (VM600Mk2/VM600 and/or VibroSmart®). 

Note: To access the Sensor catalog in VibroSight Protect (or VibroSight Capture), use the Tools > Sensor catalog 
menu command. In the Sensor catalog, the category/section of the sensor catalogue is changed using the drop-
down control (top right), which shows Accelerometers as the default. 

See also 0  
 
VM600Mk2 MPC4Mk2 support for custom processing. 

 

 

2.10 Sensor configuration improvements 

The sensor catalogue used by VibroSight Protect for the configuration of sensor / measurement chains has been 
improved to allow the easier configuration of sensor / measurement chains. 

More specifically, when adding a generic (non-vibro-meter) sensor / measurement chain, the parameters for the 
sensor / measurement chain are presented more visually, including a “transfer function” / “characteristic curve” that 
makes it easier to verify and understand the operation of the sensor / measurement chain.  

Note: To access the Sensor catalog in VibroSight Protect (or VibroSight Capture), use the Tools > Sensor catalog 
menu command. To add a sensor / measurement chain to the Sensor catalog, use the Add control (bottom left) 
and select Add vibro-meter sensor chain or Add generic sensor chain, as appropriate. 

 

 

2.11 VibroSight Protect configuration export 

VibroSight Protect can now export a copy of a VM600Mk2 system configuration in a human-readable format in order 
to more easily support activities such as factory acceptance testing (FAT), manual comparison of configurations, 
system documentation and so on. 

In VibroSight Protect, use the File > Export menu command to export the current configuration to the Excel® file 
format (*.xlsx). 

In the Excel® file, the VibroSight Protect configuration is saved as a multi-sheet document as follows: 

• One System layout sheet containing general rack/system information. 
(In general, the System layout sheet corresponds to the general rack/system information from the Layout 
tab/page in VibroSight Protect.) 

• One Slot nn sheet per module containing more detailed configuration information. For example, card 
properties, channels (measurements), logical functions, relays and analog output information for a MPC4Mk2 + 
IOC4Mk2 module. 
(In general, the Slot nn sheets correspond to module specific information from the Configure tab/page, for the 
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selected module/slot, in VibroSight Protect.) 
Note: One Slot nn sheet is exported per configured module / used rack slot in the VM600Mk2/VM600 rack.) 

2.12 VibroSight System Manager and VibroSmart PTP time synchronisation 

VibroSight System Manager has been updated to support how VibroSmart® modules now use the precision time 
protocol (PTP) in order to improve measurement time synchronisation (<1 msec) between different VibroSmart 
modules for all types of measurements, in particular waveforms, when using a VibroSmart VSN010 real-time 
Ethernet switch as a PTP bridge. 

More specifically, for a VibroSmart system using a VSN010 as a PTP bridge for other VibroSmart modules 
(VSV30x and VSI010), VibroSight System Manager is used to configure: 

• For VSN010 time synchronisation: 

o PTP server: Domain ( 0-127), Transport (IPv4, Ethernet), Delay mechanism (P2P, E2E) and 
Offset compensation (-10,000 to +10,000 µsec) 

o NTP server: IP address 

o Disabled. 

• For VSV30x and/or VSI010 time synchronisation: 

o VSN010 (indirect PTP master): Automatic synchronisation with the VSN010 in its measurement block 

o NTP server: IP address 

o Disabled. 

 

In addition, VibroSight System Manager will display improved information in the Time synchronisation panel, 
displayed as part of the general/overall information in the main window (centre) when a VibroSmart module is 
selected. 

See also 2.19 VSN010 module, 2.20 VSV301 + VSB300 module and 2.21 VSI010 + VSB010 module. 

 

 

2.13 VibroSight Capture and MPC4Mk2 modules 

For the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, machinery protection 
functionality is available by default for all versions of the module, while condition monitoring functionality is optional. 

NOTE: • VibroSight Protect supports the configuration and operation of machinery 
protection system (MPS) functionality for a VM600Mk2 system 
(MPC4Mk2 + IOC4Mk2, RLC16Mk2 and CPUMMk2 + IOCNMk2 modules). 
• VibroSight Capture supports the configuration and operation of condition 
monitoring system (CMS) functionality for a VM600Mk2 system 
(MPC4Mk2 + IOC4Mk2modules). 
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Accordingly, MPC4Mk2 condition monitoring can be used by either (1) ordering a version of the module with 
condition monitoring enabled or (2) ordering and uploading a condition monitoring license (MPC4Mk2 CMS license) 
to a version of the module without condition monitoring enabled (using VibroSight System Manager). 

For example, a VibroSight / VM600Mk2 MPC4Mk2 system consisting of MPC4Mk2 + IOC4Mk2 modules can initially be 
installed and used as a MPS only. Then, CMS functionality can be quickly and easily added at any time by 
upgrading the licenses for the MPC4Mk2 + IOC4Mk2 module(s) and for VibroSight software, as required. 

Starting with VibroSight 7.1.0, VibroSight Capture now checks all MPC4Mk2 modules in a configuration/system to 
verify if they have a valid condition monitoring license (MPC4Mk2 CMS license) before working with the modules in 
order to limit the functionality and presentation of information in VibroSight Capture accordingly. 

(Previously, VibroSight Capture assumed and treated all MPC4Mk2 modules as if they had a valid condition 
monitoring license (MPC4Mk2 CMS license).) 

 

Now, for a MPC4Mk2 module that does not have a valid condition monitoring license (MPC4Mk2 CMS license), 
VibroSight Capture will no longer display any condition monitoring system (CMS) information such as condition 
monitoring specific measurement processing and outputs. 

However, VibroSight Capture will continue to allow access to the machinery protection system (MPS) information 
for a MPC4Mk2 module, such as machinery protection specific measurement processing and outputs. Importantly, 
this allows the MPS-related data (specifically, static measurement data) to be logged to a VibroSight database. 

 

 

2.14 VibroSight Vision and Trend plots against speed and against time 

In VibroSight Vision, for the display of Trend plots against speed (Speed/Bode), a new speed-specific decimation 
algorithm is now being used in order to optimise the display of data against speed. 

(Previously, for the display of Trend plots against speed (Speed/Bode), the decimation applied was the same as for 
the display of Trend plots against time (Time/APHT), which was not entirely suitable and sometimes resulted in 
measurements not being displayed.) 

 

Similarly, in VibroSight Vision, for the display of Trend plots against time (Time/APHT), the existing decimation 
algorithm used has been improved in order to further optimise the display of data against time. More specifically, 
for curves displaying elapsed time, the same number of points are used per curve. 

NOTE: Elapsed time is used when multiple machine states or alarms are selected for the 
time range. When elapsed time is used, a curve is created per selected time 
period, with all curves starting from 0 seconds (x-axis), in order to allow for easier 
data comparisons. For example, this is open used compare multiple runups and/or 
rundowns of a machine. 
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Further, to allow for the customisation of the new speed-specific decimation, a user-configurable performance limit 
has been added to the VibroSight Vision options that allows the maximum number of measurement points used for 
plots against speed to be limited. 

To access the VibroSight Vision performance limits, use the Tools > Options menu command and in the Options 
window that is displayed, click Performance (left) to display the performance limits information. 

Under Plot data display limits: 

• Maximum plot dynamic data items: 250 (default value) 
Defines the maximum number of waveforms, spectra or orbits that can be displayed in a plot. 

• Maximum data items for curves in function of speed: 4000 (default value) 
Defines the maximum number of points that can be displayed in each static curve in a plot displayed against 
speed. 
Note: This is the new limit used for the display of Trend plots against speed (Speed/Bode). 

 

 

2.15 Machinery view changes 

In the Machinery view window, the hierarchical tree structure used to display information about the machinery 
being monitored has been improved such that only machine train components that have measurement points 
attached are now displayed. 

NOTE: For a VibroSight system, VibroSight Capture is used to create a Machinery view. 
In VibroSight Capture, on the Machinery tab/page, create a machine train and add 
machinery components (such as machines, bearings, couplings and shafts) to it, 
then on the Connect tab/page, associate (connect) these components with their 
associated measurement points (defined in VibroSight Protect). 

 

This Machinery view change was made in order to make it easier to navigate and work with the Machinery view in 
VibroSight software modules that use it, notably, VibroSight Vision, VibroSight Mimic and VibroSight Event Viewer. 
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VM600Mk2 modules 

2.16 MPC4Mk2 + IOC4Mk2 module 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with the 
following main improvements: 

 

Machinery protection firmware: 640-025-006-000 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-006-000) is only 
compatible with MPC4Mk2 modules with PNR 600-041-000-002 or later. 

Uploading this machinery protection firmware (640-025-005-000) to earlier versions 
of hardware (MPC4Mk2 modules with PNR 600-041-000-001) will result in a module 
stuck in the Power-up operating mode. 

 

Features: 

• Support for hydro air-gap monitoring and analysis for machinery protection 
Air-gap processing is now supported by the module’s dynamic channels (CH1-CH4). 
See also 2.1 VM600Mk2 MPC4Mk2 support for hydro air-gap monitoring and analysis. 

• Support for shaft absolute vibration processing for machinery protection 
Shaft absolute vibration (SAV) processing, more specifically X-Y bearing absolute vibration, is now supported 
by the module’s dynamic channels (CH1-CH2 and CH3-CH4). 
Note: X-Y bearing absolute vibration processing is a dual-channel processing that uses accelerometers or 
velocity sensors as inputs. It is similar to X-Y shaft relative vibration processing, another dual-channel 
processing, that uses proximity sensors as inputs. 
See also 2.2 VM600Mk2 MPC4Mk2 support for shaft absolute vibration processing. 

Support for custom processing for machinery protection 
Custom dynamic processing is now supported by the module’s dynamic channels (CH1-CH4). Custom quasi-static 
processing is now supported by the module’s auxiliary channels (AX1-AX2). 
See also 0  
 
• VM600Mk2 MPC4Mk2 support for custom processing. 

• Improved fault-relay configuration/operation 
See also 2.6 VM600Mk2 MPC4Mk2 fault relay configuration. 

• Improved user-configurable relay configuration/operation 
See also 2.7 VM600Mk2 MPC4Mk2 user-configurable relay configuration. 

• Improved adaptive monitoring 
For adaptive monitoring, used to change alarm limits as a function of a control parameter, when using multiple 
coefficients (Trip multiplier bands), the configured bands no longer need to be contiguous (adjacent), thereby 
making configuration easier. Also, every processing measurement output compatible with adaptive monitoring 
now uses a flag to indicate if a trip multiplier is active. 
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NOTE: A trip multiplier can become active due to either adaptive monitoring (control parameter) or activation of  
the external discrete signal interface (DSI) Trip multiply (TM) control input. 

• Common module status bits 
A number of new common module status bits have been created in order to make it easier to monitor the ststus 
of modules logical functions  
• Common alert – the logical OR of all the “Alert+” and “Alert–” for all measurements in all channels within the 
MPC4 module. 
• Common danger – the logical OR of all the “Danger+” and “Danger–” for all measurements in all channels 
within the MPC4 module. 
• Common sensor NOK check – the logical OR of all the “Sensor NOK check” for all channels within the MPC4 
module. 
NOTE: Previously, these common module status bits had to be created manually using logical functions. 

 

Bug fixes: 

• Module saturation level detection (BIST) for AC-coupled signals was too low. 
• Save diagnostics log (VibroSight System Manager) was not working if module configuration files (protection or 

monitoring) were too big. 
• MPC4Mk2 module no longer activates the system-wide VM600Mk2 MPS safety-line control signal in fail-safe 

mode, also known as the “Redline”, that automatically drives all system relays (IOC4Mk2 and RLC16Mk2) and 
analog outputs (IOC4Mk2) to a safe state. 

• For Adaptive monitoring using speed as the control parameter, the flag (ADAPTIVE_INVALID) associated with 
the associated speed was not becoming active when there was a speed sensor / measurement chain problem 
(sensor NOK check). 

• Module with normally energised (NE) relays incorrectly entering the fail-safe mode/state following a 
reconfiguration (VibroSight Protect) or firmware upgrade (VibroSight System Manager). 

• Using the IP settings (VibroSight System Manager) to change the IP address of an MPC4Mk2 + IOC4Mk2 module 
not working correctly due to “locked” modules always responding. 

• Improved filtering for an ADC (XADC) on the IOC4Mk2 module to better suppress glitches and reduce noise on 
DC measurements. 

• Changing IP address of Cards/Modules reports that module is locked. 
• Improve XADC glitch filtering on DC channels. 

 

 

Condition monitoring firmware: 640-033-002-000 

NOTE: VM600Mk2 MPC4Mk2 condition monitoring firmware (640-033-001-000) is only 
compatible with machinery protection firmware (640-025-006-000), and with 
MPC4Mk2 modules with PNR 600-041-000-002 or later. 

 

Features: 
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• Support for hydro air-gap monitoring and analysis for condition monitoring 
Air-gap processing is now supported by the module’s dynamic channels (CH1-CH4). 
See also 2.1 VM600Mk2 MPC4Mk2 support for hydro air-gap monitoring and analysis. 

• Support for shaft absolute vibration processing for condition monitoring 
Shaft absolute vibration (SAV) processing, more specifically X-Y bearing absolute vibration, is now supported 
by the module’s dynamic channels (CH1-CH2 and CH3-CH4). 
Note: X-Y bearing absolute vibration processing is a dual-channel processing that uses accelerometers or 
velocity sensors as inputs. It is similar to X-Y shaft relative vibration processing, another dual-channel 
processing, that uses proximity sensors as inputs. 
See also 2.2 VM600Mk2 MPC4Mk2 support for shaft absolute vibration processing. 

Support for custom processing for condition monitoring 
Custom dynamic processing is now supported by the module’s dynamic channels (CH1-CH4). Custom quasi-static 
processing is now supported by the module’s auxiliary channels (AX1-AX2). 
See also 0  
 
• VM600Mk2 MPC4Mk2 support for custom processing. 

 

Bug fixes: 

• Condition monitoring configurations containing an auxiliary channel with custom quasi-static processing or a 
remote tacho being rejected. 

• Condition monitoring configurations containing an integration (for example, from acceleration to velocity) not 
being processed correctly with the result that no integration was being performed. 

 

 

2.17 CPUMMk2 + IOCNMk2 module 

Updated VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface firmware with the following 
main improvements and bug fixes: 

Base-system / Applications firmware: 640-034-002-000 

Features: 

• Support for PROFIBUS identification number 
An Ident Number (ID number) can now be added to a PROFIBUS fieldbus configuration file. For example: 
PROFIBUS_IDENT=0x0FBE 
where 0x0FBE is the Meggitt identifier (our default value). 
(The PROFIBUS_IDENT command goes in the [GLOBAL] section of the PROFIBUS configuration file, after the 
IS_PROFIBUS_ACTIVATED command.) 
Note: This change was made for consistency between the VM600Mk2 CPUM + IOCN module and the 
VM600 CPUR2 + IOCR2 module, thereby allowing easier upgrades from VM600 CPUR2 to VM600Mk2 CPUM. 

 

See also 5.2 VM600Mk2/VM600 modules/cards. 
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VM600 modules 

2.18 CPUR2 + IOCR2 module 

Updated VM600 CPUR2 + IOCR2 rack controller and communications interface firmware with the following main 
improvements and bug fixes: 

Base-system firmware: 640-014-001-006 and Applications firmware: 640-015-001-006 

Features: 

• Support for up to two Modbus TCP servers running in parallel. 
For example, this allows one server to be allocated to the communication of vibration data (MPC4) and one 
server to be allocated to the communication of combustion data (XMC16). 

Bug fixes: 

• For MPC4 (and AMC8) card configurations updated via the VM600 MPS1 software, FSD and USED data/fields 
were not subsequently updated/displayed correctly via Modbus TCP or PROFIBUS DP. 
Note: This bug only affected Modbus / PROFIBUS and disappeared after a reboot of the VM600Mk2/VM600 
rack. 

 

See also 5.2 VM600Mk2/VM600 modules/cards. 

 

 

VibroSmart modules 

2.19 VSN010 module 

Updated VibroSmart VSN010 real-time Ethernet switch module firmware with the following main improvements and 
bug fixes. 

VSN010: 642-004-000-012: 

Features: 

• New PTP time bridge feature for use with an external PTP IEEE 1588 reference clock (PTP master), that 
allows other VibroSmart modules (VSV30x and VSI010) to use the VSN010 module as a PTP time reference 
(indirect synchronisation with PTP master). 
Note: A measurement block is now indirectly PTP synchronised with the VSN010 module broadcasting the time 
offset between the measurement block (HSR ring) time and the external reference clock time. 

 

See also 5.3 VibroSmart devices. 
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2.20 VSV301 + VSB300 module 

Updated VibroSmart VSV301 + VSB300 monitoring module firmware with the following main improvements and 
bug fixes. 

VSV301: 642-001-000-020: 

Features: 

• Time synchronisation with a VSN010 module acting as a PTP bridge (indirect synchronisation with 
PTP master). 

• Time synchronisation <1 msec between different modules for all types of measurements, in particular 
waveforms, when using a VSN010 as a PTP bridge. 

Bug fixes: 

• In order to eliminate waveform phase variations sometimes seen with VibroSmart VSV30x modules, a 
reference flag was added to waveforms to improve synchronisation between waveform and speed/tacho pulse 
signals in VibroSight. 

• Problems activating configurations on VibroSmart VSV30x modules containing Asynchronous absolute bearing 
vibration (AAB) processing. 

• Improved module event logging such that new events are correctly handled at startup (stored in local flash 
memory) and the time of the last event is no longer used to update the module time. 

• Sensor OK indication displayed by VibroSight Scope not always correct and not always corresponding to the 
measured DC value (always correct). 

 

See also 5.3 VibroSmart devices. 

 

2.21 VSI010 + VSB010 module 

Updated VibroSmart VSI010 + VSB010 communications interface module firmware with the following main 
improvements and bug fixes. 

VSI010: 642-002-000-014: 

Features: 

• Time synchronisation with a VSN010 module acting as a PTP bridge (indirect synchronisation with 
PTP master). 

• Improved support for the GOOSE (IEC 61850) communications protocol, including a new Tmin parameter that 
limits the burst repeat speeds if the deadband is exceeded a second time. 

Bug fixes: 

• General stability improvements and bug fixes related to the GOOSE (IEC 61850) communications protocol. 
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See also 2.12 VibroSight System Manager and VibroSmart PTP time synchronisation and 5.3 VibroSmart devices.  
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.1.0 software. 

 

3.2 Incorrect Raw bus line used to drive a RLC16Mk2 relay 

In VibroSight Protect, when using a VM600Mk2 MPC4Mk2 module’s logical function to drive relay 11 (RL11) on a 
RLC16Mk2 module, an incorrect Raw bus line was used (that is, Raw bus line 43 was used when it should have 
been line 45). 

 

3.3 Incorrect tacho could be selected as a speed reference 

In VibroSight Capture, when configuring condition monitoring functionality for a VM600Mk2 MPC4Mk2 module, it was 
possible to select a condition monitoring speed reference from another MPC4Mk2 module that was not actually 
connected to the first MPC4Mk2 module via the Tacho bus. 

However, in VibroSight Capture, it is not possible to change Tacho bus configurations as they are part of the 
machinery protection functionality and so must be configured in VibroSight Protect. That is, in VibroSight Capture, it 
is now only possible to select a condition monitoring speed reference that is either local (on the same MPC4Mk2 
module), or remote and already shared/linked via the Tacho bus (from another MPC4Mk2 module). 

 

3.4 Inconsistent treatment of VibroSight Protect and VibroSight Capture configurations 
after updates 

VibroSight Protect and VibroSight Capture handled updates (changes to VibroSight software 
components/packages) slightly differently such that following a software update, VibroSight Protect might not 
request the user to re-activate the configuration on a device whereas VibroSight Capture would automatically 
include updated information (on components/packages) in any VibroSight Server that was created. 

Accordingly, this could result in issues when the configuration running on a module (readback) was compared with 
the configuration running on a server. 

Note: As a workaround, the user could always just re-activate the configuration on a device, accepting that there 
were no changes (user-made) to the configuration. 

 

3.5 VibroSight System Manager 

Under certain circumstances, VibroSight System Manager inadvertently consumed too many computer resources 
(up to of 99% of CPU and 30 GB of memory), effectively preventing other software, such as a VibroSight Server, 
from running correctly. 
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3.6 Math processing block missing configuration elements 

In VibroSight Configurator, for a VibroSight Server, the user interface for the Math processing block 
(“Custom mathematical calculation engine”) was missing an element/feature. 

More specifically, when configuring a Scalar data entity level, under Mathematical expression, the 
“Available elements" block/window was missing, which made it more difficult to know which functions, constants 
and operators were available in the maths library, and to add any of these elements to an expression. 

 

3.7 Differential shaft expansion consistency check error 

In VibroSight Protect, when configuring a VM600Mk2 MPC4Mk2 module to measure differential shaft expansion using 
the dual-channel processing function Differential expansion (single taper), setting the Ramp angle (α) to 5° resulted 
in a consistency check error, even though 5° is a permitted value. 

 

3.8 Inconsistent treatment of the Hardware and Machinery views in VibroSight Vision and 
VibroSight Mimic 

The information displayed in the Hardware view and the Machinery View in VibroSight Vision and VibroSight Mimic 
was slightly different, as the input channel node levels were missing from the views displayed in VibroSight Mimic. 
This has now been corrected such that VibroSight Mimic also includes input channel node level information. 

 

3.9 Shaft axial position measurements with auxiliary channels 

In VibroSight Protect, for the VM600Mk2 MPC4Mk2 module, it is now possible to measure shaft axial position using 
the single-channel processing function Shaft axial position (shaft end) with auxiliary channels (AX1-AX2). 

(Previously, the Shaft axial position (shaft end) processing function was only available for dynamic channels 
(CH1-CH4)). 
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4 Known issues 

4.1 Security risks 

A number of Open web application security project (OWASP) security risks have been identified related to a 
UPC UA library used by the VibroSight software. This UPC UA library is from a third-party (Softing AG, Softing 
Industrial Automation GmbH) who are working on a fix. However the improved UPC UA library is not available in 
time for the release of VibroSight 7.1. 

For information, the specific issues that have been identified are: 

• CVE-2022-29862: An infinite loop in OPC UA .NET Standard Stack 1.04.368 allows a remote attackers to 
cause the application to hang via a crafted message 

• CVE-2022-29863: OPC UA .NET Standard Stack 1.04.368 allows remote attacker to cause a crash via a 
crafted message that triggers excessive memory allocation. 

• CVE-2022-29864: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to cause a server to crash 
via a large number of messages that trigger Uncontrolled Resource Consumption. 

• CVE-2022-29865 : OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to bypass the application 
authentication check via crafted fake credentials 

• CVE-2022-29866: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to exhaust the memory 
resources of a server via a crafted request that triggers Uncontrolled Resource Consumption. 

 

4.2 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

4.3 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

4.4 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 
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NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 

4.5 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 

4.6 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 
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4.7 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 

 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 

4.8 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 

4.9 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 

4.10 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 

4.11  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 

4.12  Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 
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Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC Classic 
Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 

• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 
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3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

4.13  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully installed and run. 

 

4.14  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 
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This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 

 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

4.15  Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

 

  

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

5.1 VibroSight software 

VibroSight 7.1.0 is a minor level release and replaces VibroSight 7.0.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a VibroSight 
Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 
5.1.1 Microsoft Windows operating systems 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 7.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 7.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) 
for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with 
historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the latest  Getting started with VibroSight 
installation guide. 

 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600Mk2/VM600 modules/cards 

5.2.1 Module/card firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules/cards corresponding to VibroSight 7.1.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is now: 

• Machinery protection: 640-025-006-000.Mpc4g2Fw (updated) 

• Condition monitoring: 640-033-002-000.VxeFw (updated) 

• Recovery: 640-031-003-006.Mpc4g2Fw (no change) 

• Proof test: 640-032-001-001.VxeFw (no change). 

See 2.16 MPC4Mk2 + IOC4Mk2 module. 

 

The latest firmware for the new VM600Mk2 CPUMMk2 module is now: 

• Base system: base-system-640-034-002-001.tgz (updated). 

See 2.17 CPUMMk2 + IOCNMk2 module. 

 

The latest firmware for the VM600 CPUR2 card is now: 

• Applications: applications-640-015-001-006.tgz (updated) 

• Base System : base-system-640-014-001-006.tgz (updated). 

See 2.18 CPUR2 + IOCR2 module. 

 

The latest firmware for the VM600 CPUR card remains: 

• Applications: applications-640-012-001-005.tgz 

• Base System: base-system-640-011-001-005.tgz. 

 

NOTE: In order to help distinguish between VM600Mk2 CPUx modules and VM600 CPUx 
cards, VibroSight 6.0.0 and later uses the following terminology: 
• CPUMMk2 to refer to the VM600Mk2 CPUx module with mathematical processing of 
fieldbus data and support for Modbus TCP and PROFIBUS DP (PNR 600-050). 
• CPUR2 to refer to the latest version of the VM600 CPUx card with support for 
PROFIBUS (PNR 600-026-000-VVV). 
• CPUR to refer to the earlier version of the VM600 CPUx card with support for 
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV). 
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The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Applications: applications-640-010-001-016.tgz 

• Base System: base-system-640-003-001-016.tgz. 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.1.0. 

 

The latest firmware for the VSI010 module is now: 

• 642-002-000-014.xmsifw  

See 2.21 VSI010 + VSB010 module. 

 

The latest firmware for the VSN010 device is now: 

• 642-004-000-012.redboxfw  

See 2.19 VSN010 module. 

 

The latest firmware for the VSV30x module is now: 

• 642-001-000-020.xtranfw  

See 2.20 VSV301 + VSB300 module. 

 

Therefore, for current versions of VibroSmart modules and devices, firmware upgrades are required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 
hardware (XMx16 cards and VibroSmart modules and devices) before starting a 
VibroSight system upgrade, in order to establish if any firmware updates are also 
required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. See 6.2.3 Updating the 
firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 modules/cards 
(XMx16) and VibroSmart devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to 
take advantage of improvements to the VibroSight software. 

Updating the firmware for VM600Mk2/VM600 modules/cards cards or VibroSmart devices is a special task that can, 
if used unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 
acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 
they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. For example, the XMV16 subfolder contains the applications and base system 
firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored 
in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 3 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 4 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 5 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- 640-033- 

001-000 

640-033- 

002-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

6.0.0 
609-004-000-050 

 See note 1  
   

6.1.0 
609-004-000-051 

  See note 2   
 

7.0.0 
609-010-000-001 

   See note 3a  See note 3b 
 

7.1.0 
609-010-000-001 

     See note 4 

 

Notes for Table 1 (see the next page) 
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Notes for Table 1 
1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
 

2. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
3a. These versions of VM600Mk2 MPC4Mk2 firmware: 
• Improve support for machinery protection with 640-025-004-003 machinery protection firmware running on earlier versions of hardware only 
(MPC4Mk2 modules with PNR 600-041-000-001). 
• No support for condition monitoring on earlier versions of hardware (MPC4Mk2 modules with PNR 600-041-000-001). 
• Improve system recovery (640-031-003-006 recovery firmware). 
• Improve proof testing (640-032-001-001 proof test firmware). 
For further information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3b. These versions of VM600Mk2 MPC4Mk2 firmware: 
• Improve support for machinery protection with 640-025-005-000 machinery protection firmware running on later versions of hardware only 
(MPC4Mk2 modules with PNR 600-041-000-002). 
• Add support for condition monitoring with 640-033-001-000 condition monitoring firmware running on later versions of hardware only (MPC4Mk2 
modules with PNR 600-041-000-002). 
• Improve system recovery (640-031-003-006 recovery firmware). 
• Improve proof testing (640-032-001-001 proof test firmware). 
For further information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. These versions of VM600Mk2 MPC4Mk2 firmware: 
• Improve support for machinery protection with 640-025-006-000 machinery protection firmware running on later versions of hardware only 
(MPC4Mk2 modules with PNR 600-041-000-002). 
• Improve support for condition monitoring with 640-033-002-000 condition monitoring firmware running on later versions of hardware only 
(MPC4Mk2 modules with PNR 600-041-000-002). 
See 2.16 MPC4Mk2 + IOC4Mk2 module for further information. A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 2: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034-001-000 640-034-001-001 640-034-002-00 

6.1.0 
609-004-000-051 

 See note 2   

7.0.0 
609-010-000-001 

  See note 3  

7.1.0 
609-010-000-001 

   See note 4 

 

Notes for Table 2 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-034-001-xxx for 
the base system firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUMMk2 module, the dialog box 
displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-
034-000-xxx for the base system firmware, which correspond to the actual unpacked firmware that is running on the module. 
 

2. This version of VM600Mk2 CPUMMk2 firmware is the official launch release of firmware supporting VM600Mk2 systems. (Refer to the 
VibroSight 6.1 release notes for further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.17 CPUMMk2 + IOCNMk2 module.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 3: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014- 

001-001 

640-014- 

001-002 

640-014- 

001-003 

640-014-001-

005 

640-014-001-

006 

Applications firmware (*.tgz) 

640-015- 

001-001 

640-015- 

001-002 

640-015- 

001-003 

640-015- 

001-005 

640-015- 

001-006 

3.5.0 
609-004-000-042 

 See note 2  See note 3   
 

3.6.0 
609-004-000-043 

    
 

3.7.0 
609-004-000-044 

    
 

3.8.0 
609-004-000-045 

    
 

4.0.0 
609-004-000-046 

    
 

4.1.0 
609-004-000-047 

   See note 4  
 

5.0.0 
609-004-000-048 

    
 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
 

7.0.0 
609-010-000-001 

    See note 5 
 

7.1.0 
609-010-000-001 

     See note 6 

 

Notes for Table 3 (see the next page)  
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Notes for Table 3 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 
 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 
 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
 

5. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes.  
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

6. For information on this version of VM600Mk2 CPUR2 firmware, see 2.18 CPUR2 + IOCR2 module.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 4: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

7.0.0 
609-010-000-001 

  

7.1.0 
609-010-000-001 

  

 

Notes for Table 4 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 5: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 

Applications firmware (*.tgz) 

640-010-001-016 

3.4.0 
609-004-000-041 

 See note 2 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

7.0.0 
609-010-000-001 

 

7.1.0 
609-010-000-001 

 

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 6: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-002-000-010 642-002-000-011 642-002-000-012 642-002-000-013 642-002-000-014 

5.0.0 
609-004-000-048 

See notes 

2 and 3 

See notes 

2 and 4 

See notes 

2 and 5 
 

 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 

4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSI010 firmware, see 2.21 VSI010 + VSB010 module.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later.  
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Table 7: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 642-004-000-012 

5.0.0 
609-004-000-048 

 See note 2 
 

5.1.0 
609-004-000-049 

 
 

6.0.0 
609-004-000-050 

 
 

6.1.0 
609-004-000-051 

 
 

7.0.0 
609-010-000-001 

 
 

7.1.0 
609-010-000-001 

 
See notes 

2 and 3 

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSN010 firmware, see 2.19 VSN010 module.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 8: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-017 642-001-000-018 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 642-001-000-020 

5.0.0 
609-004-000-048 

See notes 

2 and 3 

See notes 

2 and 4 

   

5.1.0 
609-004-000-049 

  
See notes 

2 and 5 
 

 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

4. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 

6. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSV30x firmware, see 2.20 VSV301 + VSB300 module.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 module/card firmware update may lead to 
incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only in systems 
where the firmware running on the XMx16 cards and VibroSmart devices already corresponds to the latest 
available version that no firmware update is required. Therefore, it is strongly recommended to verify the version of 
firmware running on the hardware before starting a VibroSight system upgrade, in order to establish if a firmware 
update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 
that can – if performed unintentionally – affect the proper functioning of data 
acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 
hardware only when it is necessary. For example, when the devices must be 
updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 
card or VibroSmart module or device) to be updated. 
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2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 
network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VibroSight-compatible VM600Mk2/VM600 module/card or 
VibroSmart device selected. 

In general, .tgz files are for VM600Mk2/VM600 modules/cards and .*fw files are for 
VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 
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The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 
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VibroSight software and Microsoft® .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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